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Welcome to PlanetPress® Connect, the new and highly dynamic document composition solution from 
Objectif Lune! PlanetPress® Connect is the link between your data systems and your customer 
communications. It allows you to create fully personalised business correspondence across a range of 
output types and manage these via sophisticated and automated workflows. 
 
Key aspects of PlanetPress® Connect include the following: 
 

 DataMapper – Extract data from multiple sources and output it in a single format 
 

 Designer – design tool for creating print, email and web communications 
 

 Output – advanced output and print stream handling across industry-standard print formats 
 

 Workflow – for automating the production of output from PlanetPress® Connect 
 
 
Installing PlanetPress® Connect Version 1.0.1 and PlanetPress® Workflow 8.0.1: 
 
Full details on downloading, installing and licensing PlanetPress® Connect 1.0.1 and PlanetPress® 
Workflow 8.0.1 can be found in the accompanying “PlanetPress Connect Version 1.0.1 - Installation 
and Activation” document.  
 
Note that both PlanetPress® Connect 1.0.1 and PlanetPress® Workflow 8.0.1 come with 30 day trial 
licenses by default. 
 
 
32 Bit Version Only 
 
Note that PlanetPress® Connect 1.0.1 is released as a 32 Bit version only. A 64 Bit version of Connect 
will be introduced in a later release.  
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This sections provides some basic tips on getting started with PlanetPress® Connect as well as details 
on some of the highlights of the application. 
 

1. Opening PlanetPress® Connect 

 
After PlanetPress® Connect has been installed, it can be opened via the following options in the Start 
menu: 
 

 
 

 Connect Designer - opens the PlanetPress® Connect Design Tool 

 Connect Server Configuration – opens a tool for managing job scheduling and security for 
the server as well as clean-up options 

 Connect Software Activation – opens the Software Activation tool which allows you to load a 
license file and view the terms of the End User License Agreement. 

 Release Notes – Opens the current version of the PlanetPress® Connect Release Notes 
 

2. Fast Access to Information 

 
PlanetPress® Connect includes an extensive online help system providing detailed information on 
most areas of the application. Use the “Help Topics” option in the Help menu or press F1 to access 
the home page of the help: 
 

 
 
Note that in Version 1.0.1, all calls to the online help from the application will default to the home 
page of the help. Context sensitivity will be introduced to the help system in a later release. 
 
This menu also provides access to the PlanetPress® Connect “Welcome Screen” which provides 
wizards and tips for setting up templates.  
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3. Welcome Screen for Getting Started 

 
When first starting the Connect Designer, a Welcome screen is displayed which helps you to quickly 
become acquainted with all of the key areas of PlanetPress® Connect: 
 

 
 
The links in the “Resources”panel provide further information about PlanetPress® Connect and 
Objectif Lune: 
 

 Knowledgebase – opens a page in the Objectif Lune knowledgebase which will eventually 
contain information on PlanetPress® Connect. 

 Documentation – opens the PlanetPress® Connect online help. 

 Course (OL Learn) – opens the OL Learn site where you can access any OL courses available 
to you. 

 Release Notes – opens the current release notes. 

 Newsgroup – opens a page with discussion forums around various Objectif Lune products. 

 Website – opens the Objectif Lune website. 

 Take a tour – provide an interactive tour of PlanetPress® Connect with videos and 
presentations. 

 
 
Turning the Welcome Screen on and off: 
 
A “Do not show again” checkbox in the “Welcome” screen enables you to turn the screen off so that 
it no longer opens by default when starting Designer. 
 
You can call the “Welcome” screen back at any time using the Help menu or via the following button 
in the standard toolbar: 
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Template Options: 
 
The Template options in the “Welcome” screen enable you to: 
 

 Create a new Template 

 Access the available Template Wizards 

 Open an existing Template 
 
The following page is opened when selecting “Create Template”. Select an Email, Print or Web 
context for your template. Other contexts can be added later if required: 
 

 
 
 
 
Sample Templates: 
 
A selection of sample templates for previewing the functionality in PlanetPress® Connect are 
available from the following online demo portal: 
 
http://connectdemos.ca.objectiflune.com 
 
 
 
  

http://connectdemos.ca.objectiflune.com/
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DataMapper Options: 
 
The DataMapper options in the “Welcome” screen enable you to: 
 

 Create a new DataMapping configuration 

 Open an existing DataMapping configuration 

 Open a DataMapping configuration from a “Recent” list 
 
The following options are displayed when opting to create a new DataMapping configuration. 
Clicking on a box opens settings appropriate to the selected type: 
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4. Template Wizards 

 
PlanetPress® Connect includes various easy-to-use wizards for setting up basic Email, Print, Web 
Page, Letter and Foundation Web Page templates. To access the wizards click on Template Wizards in 
the Welcome screen or go File|New to select the wizard there: 
 

 
 

 

Selecting one of the options opens a Wizard in which you can set up basic properties for that context. 
The following example shows the steps associated with setting up Banded Email and Banded Invoice 
templates. The New Banded Email Action Template wizard allows you to specify the colours of the 
bands, a logo and the subject and header text: 
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Clicking “Finish” will create the Banded Email template: 
 

 
 
 

Select the “Invoice” option in the 
“New” dialog to create a Banded 
Invoice template. This opens a 
similar dialog with additional 
settings for the payment button 
and detail table: 

 

 

 
 
 
 
 
 
 
 
 
Clicking “Finish” creates the 
Banded Invoice template: 
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5. Data Model 

 
The Data Model in PlanetPress® Connect is a separate standalone entity. The Data Model pane 
includes 3 buttons which allow you to import, export and synchronize a model: 
 

 
 
The entries in the Data Model pane are displayed in red when synchronization is required. Press the 
button to perform the synchronization. After this the entries will be displayed in black again. 
 
 

6. Record Navigation in the Data Model Panel 

 
The Data Model panel allows you to navigate through data records and, in the case of transactional 
sources, their individual detail records. You can navigate forwards or backwards through the 
records\details using the buttons or enter a number directly in the edit box: 
 
 

 
 
 
  



13

 
 

 
 

 

7. Generate Counters 

 
PlanetPress® Connect supports the generation of counters in the DataMapping Wizard. The 
“Generate Counters” option is included the “Select a Wizard” dialog and also under File|Add Data: 
 

 
 
 
This opens the “Set counters options” dialog: 
 

 
 

With the settings in the above example, 1000 records would be created with 1 field counter 
per record (i.e., 1, 2, 3,…….1000). 
 
Whereby: 
 

 The “Starting value” = 1 (min 0, max 999 999 999) 

 The “Increment value” = 1 (min 0, max 999 999 999)  

 The “Number of Records” = 1000 (min 0, max 999 999 999) 

 The “Padding character” = 0 (1 character only) 

 The “Width” = 0 (min 0, max 100) 

 The Prefix and Suffix are empty. 
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8. DataMapper - Undo\Redo for Step Properties 

 
Undo\Redo support is available for the step properties in the DataMapper: 
 

 
 

9. DataMapper –Cut\Copy\Paste supported for Steps 

 
The Cut, Copy and Paste options in the Edit menu can be used for the steps in a DataMapping 
configuration:  

 
 

10. TXT Mode in the DataMapper 

 
In TXT mode, when drawing a selection or when clicking on an existing one, the status bar displays 
the coordinates for that selection. 
 
The status bar information for a selection is: 
 
Selection: (C1, L1) - (C2, L2) => (w X h) 
 

where 

 C1: Left column 
 L1: Top Line 
 C2: Right column 
 L2: Bottom line 
 w: width (in columns) 
 h: height (in lines) 

 
  



15

 
 

 
 

 

11. DataMapper – Next Occurrence option for Target Type 

 
In both TXT and PDF modes, the Goto step has the option of moving the current position to the “Next 
Line with Content”. PlanetPress® Connect includes a “Next occurrence of” option in the Target Type 
dropdown list: 
 

 
 
When selecting this option, the standard “Inspect entire page width” checkbox is displayed. However 
in between both controls, an additional edit box is available called “Regular Expression to look for”. 
This allows you to enter a RegExp that is evaluated for each line in the source data. When a match is 
found (within the zone defined in the “Inspect page width” option), the current position is moved to 
that line. 
 
Java Regular Expressions can be specified e.g., modifiers such as (?i) can be used. They can be 
inserted anywhere in the RegEx and apply to everything to the right of the modifier. 
 

12. Adding and Deleting Contexts 

 
PlanetPress® Connect allows you to add and delete a context from a template via corresponding 
options in the Resources context menu: 
 

 
 

Note that a template must contain at least one context which means that the final context cannot be 
deleted.  
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13. Pie Chart Tool 

 
PlanetPress® Connect allows you to set up basic 3-dimensional pie charts:  
 

 
 

The Pie Chart tool is called via the following icon in the toolbar:  
Or via the Business Graphic option in the Insert menu: 
 

 
 
It allows you to specify static or dynamic labels and assign values for each segment: 
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14. Bar and Line Charts 

 
PlanetPress® Connect supports the insertion of basic Bar and Line charts: 
 

  
 

The Bar and Line Chart tools are called via the following buttons in the toolbar:  
Or via the Business Graphic option in the Insert menu: 
 

 
 
They allow you to specify static or dynamic labels and assign values for each bar or line position: 
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15. Inserting Barcodes 

 
PlanetPress® Connect includes a range of 1D and 2D barcode symbologies: 
 

 
 
Simply click on the new down arrow next to the Barcode icon in the toolbar to open up a list of 
available barcodes or go to Insert|Barcode: 

 
 
 

 

 
After you have selected a barcode type from 
the list, the Edit Script dialog is opened in which 
you can specify the value of your barcode.  
 
You can add one-to-many fields for the value of 
the code by using the green plus button. Each 
line in the table allows you to specify the 
following: 
 

 Prefix – free text field for specifying 
static information to prefix the field 
value 

 Field – for specifying the required field 
for the barcode value from a dropdown 
list 

 Format – specifies whether the value 
should be upper case or lower case. 
Leaving the box blank means display 
the value as specified in the data 

 Suffix – free text field for specifying 
static information after the field value 

 
 
 
Properties Dialogs for Barcodes: 
 
Each barcode type has its own properties dialog. After inserting the barcode into your template, 
right-click to open the context menu and select the properties option for the barcode. Different 
properties dialogs are displayed depending on the barcode type. The following are some examples:  
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The Royal Mail Mailmark dialog allows you 
to specify the number of dots per pixel, the 
required format (C24X24, C32X32 and 
C16X48) and the scale. 

 

 
 
The KIX and Australia Post 4-state barcode 
properties allow you to specify the bar 
height and width properties, the spacing 
and the scale. 
 
 
 

 

 
 
 
The Aztec Properties dialog allows the 
specification of the module size, 
configuration settings, error correction 
level and encoding.  

 
  

 

 
 
 
 
The UPC-E dialog allows you to specify the 
module properties, supplement and HRT 
settings. 
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16. Special Characters  

 

 
 
Special Characters can be inserted via Insert|Special Character. These include: 
 

 Symbols - as pictured above 
 

 Markers – Page Number and Page Count 
 

 Dashes and Spaces – various hyphens, dashes and spaces 
 

 Arrows – Left, Right, Up, Down 
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17. Text Script Option in Context Menu 

 
A Text Script option is included in the context menu for a range of selected text: 
 

 

 

 Mark a range of text and call the context menu 
 

 Select the Text Script option to open the Text 
Script wizard 

 

 The name of the script is set to the selected text 
 

 The value of Find Field is set to the selected text 
 

 The created Text Script replaces the selection with 
the value of the specified data field 

 
 

 
 

18. Script Wizards: Simplified Conditional Content 

 
Select an element on the page, perform a right mouse click and select “Make Conditional” from the 
context menu. The Condition wizard appears allowing the user to select a data field, set the condition 
and enter/set the value to be validated. 
 
This has been implemented for the following field types: 
 

 String & HTML String 

 Boolean 

 Integer, float, currency 
 
Use the ID of the selected element or create an ID on the fly. 
 
Note that Date fields are currently not included.  
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19. Multiple Conditions 

 
PlanetPress® Connect supports the creation and evaluation of multiple conditions: 

 

 
 
 

 When selecting a condition, it is highlighted in the tree and its properties are shown in the 
Condition section. The corresponding fields related to this condition are also highlighted in 
the editor. 

 
 Boolean operators between the two conditions can be changed either by right-clicking to 

make the popup appear or by double-clicking the operator. The value will then change to the 
next operator i.e., (AND -> OR -> XOR -> AND, etc) 

 
 When a condition is deleted, the orphan condition is paired to the last one on the parent 

level and its operator is deleted. 
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20. Numbered and Bulleted Lists 

 
PlanetPress® Connect supports numbered and bulleted lists via the following buttons in the toolbar: 
 

 
 
 

 
 
 
 
 

21. WYSIWYG Editor for Snippets 

 
PlanetPress® Connect allows you to edit a Snippet in the Template window. Simply double-click on 
the Snippet in the Resources window for it to appear in the Template window where it can be edited 
and saved in either the Source or Design pane: 
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22. Applying Table Properties 

 
Various options are available for specifying the properties of tables. 
 

 The Table Formatting dialog includes Height, Corner radius and Display settings as well text 
wrapping and positioning options. Other tabs allow Spacing and the Background to be 
defined: 

 
 

 The Table Cell Formatting dialog contains a Height and Width options and a Vertical Align box 
with a dropdown menu containing the alignment options: 
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 Various “Style” options are available when inserting a table including a “No Style” option: 
 

 
 

 
Other options for tables: 
 

 New tables can be inserted without a header row (set the value to zero) 
 

 The selection of multiple table cells is supported via both “Shift + mouse-click” and “Control + 
mouse-click” 
 

 Support is provided for numeric subtotals in tables. 
 

 

23. Dynamic Detail Tables 

 
PlanetPress® Connect makes it easier to set up dynamic detail tables. It allows you to link a table to a 
detail table and subsequently define the <tr> elements that should be repeated. 
 

 A “Detail Table” option is included in the submenu for <table> elements in the context menu 
 

 The submenu shows a list of current detail tables, including an option “None” and a possible 
custom value set for the “data-detail” attribute of the table. 

 

 If the “data-detail” attribute of the <table> element is empty, None is used. If a match is 
found for the attribute, the item shows a mark next to its name. 

 

 If a "data-detail"-attribute has a value that does not exist in the list, this value is shown at the 
beginning of the list, again with a tickmark/bullet next to its name (e.g. a value that doesn't 
match any of the detail table names in the data model). 
 

 A "Repeat" option has been added to the end of the end of the submenu for <tr>elements in 
the contextual menu and in the Attributes panel for <tr> elements. This adds the "data-
repeat" attribute to the selected <tr> element. 

  



26

 
 

 
 

 

24. Locale Setting 

 
A “Locale” can be specified under Edit|Locale: 
 

 
 
Setting the locale allows the script wizards to be based on one of the following: 
 

 The System Locale 

 An Explicit Locale – choose from a global list in the “Locale” control 

 Dependent on a database field which is then specified in the “Data field” control 
 
When the locale is based on a data field, the locale will always correspond to the current record. 
 
When the value of the locale in the field has not been specified or is erroneous (e.g., misspelled or 
mistyped), the default locale for the Java environment is used. 
 

25. Preferences 

 
PlanetPress® Connect allows you to set up general preferences for the cleanup service, e-mailing, 
printing, scheduling and Emmet via Window|Preferences: 
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26. Supported Images Types 

 
PlanetPress® Connect supports the following image types which are available from the Images folder 
in the Resources panel: 

 

 .ico 

 .swf 

 .tif 

 .tiff 

 .svg 

 .jpg 

 .eps 

 .pdf 

 .gif 

 .png 
 

27. Images can be absolute positioned in the Master Page element  

 
PlanetPress® Connect allows images inserted onto Master Pages to be absolute positioned when 
dragging and dropping. This includes dragging and dropping images from the Images folder in the 
Resources panel as well as dragging images from the file system. 
 
 

28. Absolute Positioned and Inline Boxes 

 
Cutting, copying and pasting is supported for absolute positioned and inline boxes. Note that if you 
copy and paste an absolute positioned box, the new box is placed over the top of the old one and the 
new box is selected. Visually it appears that nothing has happened until you drag the box to the new 
location when the original box will be seen underneath. 
 
 
 

29. Color Management 

 
PlanetPress® Connect supports Color Management for the following: 

 

 Indexed images 

 Tint swatches 
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30. PreFlight Option 

 
A “Preflight” option is available from the Context menu which allows you to validate the records in 
your template against various errors. Any errors found are listed in the “Preflight” dialog along with 
the section and record in which they occurred: 
 

 
 
 
The “Preflight” check looks for the following: 
 

 Missing shared content e.g., missing snippets, resource file not found etc. 

 Data integrity – checks each record for workflow errors, currency errors, date errors etc. 

 Missing fields – references to missing fields in scripts 

 E-mail – common mistakes such as absolute positioned boxes, use of the transform style, 
<form> and <input> elements, background images, missing e-mail subject, invalid e-mail 
addresses etc. 

 Integrity of hyperlinks  

 Load errors 

 Missing images 

 Content overflow 

 Syntax errors 

 Custom runtime errors and warnings 

 System-generated runtime errors 
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31. Automation Using PlanetPress® Workflow 8: 

 

 
 
If you wish to use PlanetPress® Workflow (automation) in conjunction with PlanetPress® Connect, 
you will need to install PlanetPress® Workflow 8 onto the same machine.  

 
PlanetPress® Workflow 8 can be installed in parallel on the same machine as an existing PlanetPress® 
Suite 7.x installation. Note however: 
 

 If both versions need to be hosted on the same machine, PlanetPress® Workflow 8 should 
always be installed after the legacy PlanetPress® Suite 7.x installation.  

 When uninstalling PlanetPress® Workflow 8, you may be prompted to repair your legacy 
PlanetPress® Suite 7.x installation.  

 If PlanetPress® Workflow 8 is installed alongside PlanetPress® Workflow 7, Capture can no 
longer be used with Workflow 7. The plugins are now registered uniquely to Workflow 8 and 
the messenger for Workflow 7 is taken offline. It is only then possible to use Capture from 
PlanetPress® Workflow 8. 

 
Note that Fax and Archive in PlanetPress® Workflow 8 will not fax and archive with indices with 
PlanetPress® Connect 1.0.1. This will be introduced with Version 1.1 of Connect. 
 
For more information on installing and licensing Workflow 8, please see the accompanying 
PlanetPress® Connect 1.0.1 Installation and Activation guide. 
 

32. Package Files for Workflow 8.0.1 

 
A “Package Files” option is included in the File menu which allows you to package up your Template, 
Data mapping configuration, Job Creation Preset and Output Creation Preset and send them to 
Workflow 8 for automation or to a file: 
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33. Print Wizard 

 
PlanetPress® Connect provides a Print Wizard for easily making your output specific settings. Go 
File|Print and then select the “Advanced” button in the subsequent dialog to open the wizard: 
 

 
 
 

 Select the required “Printer Model” from the dropdown list (dependent on your license) 

 Specify the “Output Type” e.g., Windows Printer 

 Select the required “Production Options” (note that Booklet Imposition is not supported in 
Version 1.0.1) 

 Specify the records to be produced and whether filtering and sorting should be applied 

 Specify the number of copies and whether they should be collated. 
 
The following pages of the Print Wizard will then depend on the options you have selected on the 
start page. 
 

34. Metadata Support 

 
In PlanetPress® Connect, data can be passed to the output engine for the creation of metadata for: 
 

 PDF-VT tags 

 Tagged Logical Elements (TLE's) 

 Archive Indexes 
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35. Data Filtering Options 

 
The Print Wizard includes various options for filtering data as shown in the following illustration: 
 

 
 
Note: when using only the Designer without the Server installed, only the “Field rule” and “Document 
Length rule” will be applicable. This is because the content sets generated from the standard Print 
Wizard are a single template/data combination. In the Server environment it is intended that users 
can merge multiple content sets in a single run and so the additional options allow filtering of specific 
content. 

It is possible however to create configurations using these rules and save them for use in the Server 
environment. 
 

36. Separation Options 

 
Separation options, including page count splitting, can be specified on the following page of the Print 
Wizard:  
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37. Finishing 

 
The following Finishing options are supported in PlanetPress® Connect: 
 

 Tray\media selection, cut & stack and n-up 

 Subset stapling of individual documents, corner stapling of both portraint and landscape 
documents; subset booklet printing and saddle stitching with fixed page count signatures  

 Mixed unstapled and subset-stapled documents 

 Subset finishing is supported in the output engine. 

 Stapling can be applied to a complete document with sub sections 

 Jogging 

 Slipsheet capabilities in the Printer Definition config 

 Finishing at PCL document level 

 Finishing at PS\PCL section level 
 

38. Finishing Options for PostScript® Printers 

 
PlanetPress® Connect supports Finishing on a document level for any PostScript® printer: 
 

 The Finishing options are governed by a Printer Definition Configuration (PDC) file which 
must be loaded in the Advanced settings in the Print Wizard. 

 

 The PDC needs to contain all of the finishing settings available to your PostScript® printer.  
 

 The PDC provides more power and flexibility than a regular PPD in that it allows the inclusion 
of logic and conditional processing and also forms a basis for extending this power to other 
datastreams in the future. 

 

 The PDC files are created and supplied by the Objectif Lune Support Team. Please contact 
your local Support team for more information. 
 

 Some example PDC’s are provided with Version 1.0.1 as a reference (ol.printerdefinition).  
 
The following shows an extract from an example PDC: 
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Why is using a PDC more powerful than a PPD?  
 
Using a PDC provides more power and flexibility because it allows you to: 

 Gather information about the job as a whole (e.g., the media and finishing settings used, 
number of pages, number of documents, etc.) 

 Conditionally insert commands (e.g., only put a setpagedevice at the beginning/end of a 
sheet instead of at each logical page) 

 Define subset finishing (e.g., perform actions on document, set, segment and job boundaries) 

 Perform logically related settings in a single command (e.g., all the media-related settings are 
in a single insert, avoiding the possibility of specifying one setting but not the other) 

 A PPD only allows you to select from a list of values (which is usually a closed list) while a PDC 
allows you to insert properly encoded arbitrary values (e.g., names, colours, weights of media 
which may not be included in a PPD) 

 
 
What is the relationship between the PDC and the Finishing settings in the GUI? 
 
The PDC enables the Finishing controls in the PlanetPress® Connect Designer GUI. It specifies which 
Finishing controls set in the GUI will be applied on production of the template. 
 
For example, if you select “Stapled” in the Designer, stapling will only be applied providing it is 
supported in the PDC. 
 
In other words, all of the Finishing options are available for selection in the GUI but they must be 
present in the associated PDC in order for them to work.  
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What about the Override Finishing options in the Print Wizard? 
 
Any “Binding” or “Hole Making” option set in the Designer which is supported by the PDC can be 
overridden by the corresponding settings in the Print Wizard: 
 

 
 

 Specify the style of binding e.g., Ring, Stapled, Glued, Stitched etc. 

 Specify the location, area and angle of the binding 

 Specify the number of holes required and the pattern.  

 Note the the “Section to edit” control is not currently supported 

 

Overriding Finishing in Multiple Sections 

 

Ignore Section level finishing and apply all finishing at a document level 

To do this, check the "Ignore section level finishing" checkbox and set the required binding and hole 
options. At print time this will apply the specified finishing options to the entire document rather 
than applying finishing at individual section levels. For example, if a template has 2 sections and 
document level stapling is applied, the pages from both sections will be combined and stapled as one 
single document. 

Override a combination of document and section finishing 

In this scenario, uncheck the "Ignore section level finishing" checkbox and use the “section to edit” 
combo box to select the required finishing settings for document and section levels. For example, if 
you had a two section template you could apply stapling on each of the sections individually and then 
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apply ring binding to the entire document. This would result in a ring bound document consisting of 
two stapled sections. 

Ignore document level finishing and override section level finishing 

In this scenario you would perform the following: 

 Uncheck the "Ignore section level finishing" checkbox 

 Select document finishing in the combo box and specify "None" for the binding style 

 Select the other sections in the combo box and apply the required finishing settings 

The result would be a document where the required binding finishing is applied to each section in the 
document but no overall binding finishing is applied to the entire document. 
 
 

39. Media Mapping for PostScript Printers  

 
PlanetPress® Connect provides two types of mapping to PostScript printers (Media and Properties) 
using the Tray Mapping table in the Printer Settings: 
 

 
 

 The table has six columns which allow the user to specify any combination of position, 
weight, type and colour 

 At least one of the position, weight, type and colour values must be specified. e.g. the 
user could specify a weight of 80 and leave all the other fields blank  

 Setting the value for a tray on one line will cause that value to be updated on all other 
lines in the table that use the same tray name e.g., if there are two media and "tray1" is 
assigned to each of them, changing the weight on one line will also change the weight in 
the other line. This keeps the trays in sync. 

 When initialised the table will contain one row for each media and will be populated with 
as much available information from the media (e.g. specified weight, type and colour) 
although this is limited by the number of trays that are specified in the printerdef. 
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For example if the template had 3 media: 

media1: weight 80, type unspecified 
media2: type letterhead, color white 
media3: type unspecified 

and the selected printerdef had 2 trays: 

tray1: 1 
tray2: 2 

the table would appear as follows: 

 

Media Tray Position Weight Type Colour 

media1 tray1 1 80 Unspecified   

media2 tray2 2   Unspecified white 

media3 tray1 1 80 Unspecified   

 
 

40. Conditional Selection of Media 

In some cases it may be necessary to apply different media for the output depending on the value of 
a data field. The Media to be conditionally specified using scripting for the sheet positions in the 
current section:  

 The media is defined for each sheet position in the Sheet Configuration dialog. The following 
sheet positions are allowed: first, middle, last, single 

 Each Media entry in the Sheet Configuration displays a script icon. Click on the icon to invoke a 
plain script editor with a script with query selector for that specific section + sheet 

 The head element of a print section will automatically receive META elements for each sheet 

 The media can be overriden by setting the content attribute of the given META element. 

 The content attribute of the META elements will initially be empty i.e., use the media as specified 
in the Sheet Configuration dialog. 

 Media set by scripts are propagated to the Main Editor in Preview and Live mode 
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41. PDF Options and Signatures 

 
A PDF Options page in the Print Wizard allows you to make PDF-specific settings. It allows you to 
select the required PDF type (PDF, PDFA-1b, PDF-X4 and PDF-VT): 
 

 
 
It also allows you to set up PDF signatures for your output. First you must set up a Keystore and add it 
to the All Keystores table. To do so, click on the green plus icon to open the following dialog. 
 

 
 

Enter a unique name for the keystore and 
browse to the required .pfx Personal Information 
Exchange file. 
 
You must then specify the required Keystore 
Type (JKS, PKCS11 or PKCS12).  
 
The Provider is set to SUN by default. Note that 
this entry will sometimes fail in Version 1.0.1 and 
should be left blank. This is a known issue and 
will be addressed in a later release. 
 
You must then enter the password associated 
with your certificate and then browse to the 
required Properties File i.e., security certificate 
(format = .cer).  

When you have finished making your settings, click OK to add the Keystore to the table (note that if a 
Keystore is assigned to a signature, it cannot be deleted from the list): 
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You must then specify the actual PDF signature to be used in the template. Click on the green plus 
icon next to the All Signatures box to open the PDF Signature dialog: 

 
 

 

 Provide a unique name for the 
signature and select the Keystore on 
which it should be based. 

 

 Provide details about the reason for 
the signature and the contact person 
(can be left blank). 

 

 Provide the password for the 
specified Keystore (same password 
as the previous dialog) plus any Alias. 

 

 Set up timestamping if this is 
required, e.g., if you wish to use 
VeriSign (the Handler setting must 
be VeriSign PPKVS or Adobe PPKMS).  

 

 Specify whether or not the signature 
should be visible in a designated area 
in the document. 
 

 Click OK when you have finished 
making your settings to add the 
signature to the All Signatures box. 

 
Any number of signatures can be set up for the template providing that each is based on one of the 
specified Keystores. When you now produce your template to PDF, the signature you have set up will 
be assigned to your template: 
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42. Inserter Options and OMR Settings 

 
The Inserter options and OMR settings are provided on dedicated pages of the Print Wizard: 
 

 
 
 

 Specify the required inserter machine in the “Model” box 
 

 Select the OMR type and Fold type in the “Options” box, including whether the OMR should 
be printed on the front or the back. 

 

 Specify a white background for the OMR and its margins 
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Enhancements in PlanetPress® Connect 1.0.1 and PlanetPress® Workflow 8.0.1 over the previous 
releases include the following: 
 

1. In PlanetPress® Connect 1.0.1 

 

 It was sometimes not possible to start the PlanetPress® Connect Designer on a Windows VM 
on an Apple-Mac machine. This has now been fixed (SHARED-27616) 

 HTML elements can now be re-arranged by "dragging and dropping" them within the Outline 
view. (SHARED-26307) 

 Image files contained in read-only folders were not included in the output. This has now been 
fixed. (SHARED-24260) 

 Images set using the background-image property were not being included in the final PDF  
output. This issue has been fixed. (SHARED-27276) 

 After adding new media to an existing template and then saving it as a new template, the 
new template would sometimes error upon re-loading. This issue has been fixed (SHARED-
27799) 

 

2. In PlanetPress® Workflow 8.0.1 

 

 Job Sets has now been added as a retrievable type in the “Retrieve Items” plugin in order to 
allow job sets to be marked for deletion are retrieving an item. The Set Properties plugin can 
also now assign a property to a job set. (LPPS-23991) 

 Issues were encountered when creating PDF’s from Workflow 8.0.0 after upgrading from 
7.6.1. These issues have now been fixed. (LPPS-24052) 

 A conflict was occurring with parallel installations of 7.6.x and 8.0.0. The CreatePDF steps 
within 7.6.x would incorrectly point to the v8.0.0 document folders. This has been fixed. 
(LPPS-23975) 

 Issues were being encountered in the job cleanup phase, whereby files would sometimes be 
left behind. These issues have been fixed. (LPPS-23975) 

 Resources saved within PlanetPress® Connect Designer were incorrectly appearing in the 
Workflow Connect plug-in documents. This has been fixed. (LPPS-23959) 

 Issues were found during job creation after "Retrieve Items" was called. The fix for this issue 
has introduced new behavior for the Create Job plugin. It is now mandatory to choose "Use 
IDs in metadata" when the metadata contains only content items. (LPPS-23970) 
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Enhancements in the Version 1.0 release over earlier Release Candidates and Betas include the 
following: 

1. Installer Improvements 

 

 Ability to configure the Update Client for automatic notification of product updates 

 The installer now supports the user names with double-byte characters (SHARED-24325) 

 Filter added for *.OLConnectLicense in the License Activation dialog (SHARED-24975) 
 

2. DataMapper Improvements 

 
 When opening a template, the datamapper associated with the template now automatically 

opens with it and does not need to be reassigned (SHARED-25866) 

 Temporary files and folder created in the location of MDB files are now deleted (SHARED-
20296) 

 The Data Editor menu bar is now aligned correctly when the editor is resized (SHARED-20541) 

 “Undo” has been implemented for step properties (SHARED-20728) 

 Access is Denied message fixed in Generate Counters wizard (SHARED-23872) 

 Improvements in handling Thai diacritics (SHARED-24110) 

 Default values can now be defined for Data Model fields (SHARED-25564) 

 

3. Designer Improvements 

 

 Support added for toggling Switch controls (SHARED-25371) 

 Improved dialog for adding hyperlinked text (SHARED-19483) 

 Improved dialog for adding images (SHARED-19502 and 19504) 

 Improved dialog for handling section properties (SHARED-19506) 

 Improved handling of copy and paste (SHARED-19591) 

 Dragging and dropping a field now focuses the main editor (SHARED-18497) 

 Issue fixed around replacing text (SHARED-6063) 

 Improved handling of font colors, strikethrough and underline formatting in text (SHARED-
9916, 9951 and 24737) 

 Improved handing of resize placeholders and grippers for rotations (SHARED-10875) 

 Improved handling of dynamic images (SHARED-14564) 

 Multiple starting of the Designer and Server now suppressed (SHARED-19936) 

 Improved handling of the font control and name in the Font Control (SHARED-20102) 
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 Image preview improved in Resource view (SHARED-22272) 

 The Resource panel is now updated when undoing Create Snippet (SHARED-23408) 

 Improved handling of images when previewing web and email templates in external browsers 
(SHARED-23351) 

 Improved packaging of files (SHARED-23061 and 24435) 

 Scripting: empty () command introduced to remove child nodes in a set of matched elements 
(SHARED-22149) 

 Improved loading of images (SHARED-23630) 

 Improved refreshment of document boundaries (SHARED-23844) 

 Improved handling of Royal Mail Mailmark barcodes (SHARED-24367) 

 Preflight messaging improved for missing images (SHARED-24241) 

 Creating a Text Script from selected text was not reusing the existing script for the same text 
(SHARED-24218) 

 Improved scrolling arrows in wizards (SHARED-24317) 

 Improved handling of styles and structure in Email Wizard (SHARED-24358 and 24388) 

 Support added for roaming profiles e.g., when a user profile is located on the network 
(SHARED-25059) 

 Improved handling of the preflight check on UPCE barcodes (SHARED-24901) 

 Emails are now only sent to Sender in Demo mode (SHARED-24770 and 25542) 

 Improved loading of package files with presets (SHARED-24508) 

 Moving an image inside a template could sometimes removed the source value (SHARED-
24510) 

 Text style toolbar buttons now enabled for collapsed text (SHARED-24968) 

 Initial format now set for field types when creating a text script by dragging and dropping a 
data field into the Designer’s editor (SHARED-25018) 

 Outline is now updated when editing a HTML source (SHARED-24892) 

 Alerts now handled in remote merge engines (SHARED-24886) 

 Context menu made consistent for inserted object (SHARED-24652) 

 Smart Insert mode included for CSS, HTML and JS Editors (SHARED-24648) 

 Arabic is now supported (SHARED-24534) 

 Improved handling of barcode configurations (SHARED-24611) 

 Migration issue fixed when reusing an extracted template (SHARED-25554) 

 Issue fixed with conversion to upper case after applying bold or italic (SHARED-25406) 

 Improved performance when selected deeply nested text (SHARED-25603) 

 Improved handling of snippets (SHARED-26117, 26114, 25893 and 25718) 

 Add|Delete Table now available in the context menu (SHARED-25762) 

 Merge engines now automatically restarted (SHARED-25901) 



43

 
 

 
 

 

 Improved handling of subtotals in detail tables (SHARED-25428) 

 Redesigned Preferences|Scheduling dialog to prevent the specified number of Weaver 
engines becoming out of sync with the number permitted by the license file and to improve 
general usability (SHARED-24681) 

 Various other minor improvements to the Designer user interface. 
 

4. Print Wizard\Output Improvements 

 

 New Media Color option in Media Properties (SHARED-25129) 

 Improved support of Tumble options for PostScript printers (SHARED-18186) 

 Improved handing of dynamic PDF images in output (SHARED-9218) 

 Improved handling of large PDF’s (SHARED-15339) 

 Improved handling of 20K record documents when the detail table is based on a DM 
Configuration with a post processor (SHARED-17624) 

 Support has been added for EFI controller print job naming (SHARED-22619) 

 Improved PCL Finishing options (SHARED-22303) 

 Improved handling of OMR marks in output (SHARED-23469) 

 Dotted borders improved in output (SHARED-23045) 

 Sections are now outputted in the order in which they were created (SHARED-26290) 

 Watermarks have now been implemented for all output types (SHARED-21285) 

 Proof printing with watermarks has been implemented for all unlicensed versions of Designer 
(SHARED-23028) 

 Out of memory issue addressed when printing documents containing many images (SHARED-
24290) 

 Jogging now implemented for Job Segments (SHARED-24805) 

 Slipsheet support is now added (SHARED-24683) 

 Database problem fixed when running large jobs (SHARED-25077) 

 Tray mapping improved for Xerox 4112 Freeflow (SHARED-25079) 

 Improved previewing of OMR marks (SHARED-25083) 

 Email output now more aligned with Preview (SHARED-25416) 

 Improved warning messages when sending emails (SHARED-25574) 

 Preflight now checks for unsupported URL’s (SHARED-25390) 

 Improved handling of merge engines to improve performance (SHARED-25997) 

 Duplex now supported for Grouping in PostScript® (SHARED-25953) 

 Server engine timeout fixed when a job exceeded the default setting of 60 minutes (SHARED-
25792) 

 Improved handling of PDF\VT (SHARED-25881) 
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5. Workflow-Specific Improvements 

 

 A dedicated task is now available to remove data and content from the Connect database 
(LPPS-22731).  

 It is now possible to specify a section name when generating HTML content (LPPS-23813). 

 The HTTP Server now has an option to deliver a default Index.html file when a web client 
simply points to the machine's URL without any process name in the URL (LPPS-23840) 

 PlanetPress Image and the Digital action task now allow changing file properties for PDF/A 
files (LPPS-22851) 

 Improved handling of the clean up process after running for 8 hours (SHARED-22826) 

 Workflow can now create content using only process information i.e., no data (SHARED-
25567) 
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1. Commingling 

 
The Commingling functionality in PlanetPress® Connect will be licensed separately from Version 
1.1 onwards but is available for general review in Version 1.0. After the release of Version 1.1, 
the license will check whether commingling has been enabled. If it has not been enabled it will 
check during job creation that all referenced content items are sourced from a single template 
(thereby allowing batching and splitting but not commingling). 
 

2. PCL-to-PDF Plugin and PCL Input Features 

 
The PCL-to-PDF Plugin and the PCL Input feature are not available in PlanetPress® Connect 
Version 1.0. These will now be introduced in a later release.  
 

3. Using Capture After Installing Workflow 8 

 
After PlanetPress® Workflow 8 has been installed alongside PlanetPress® Workflow 7, Capture 
can no longer be used with Workflow 7. The plugins are now registered uniquely to Workflow 8 
and the messenger for Workflow 7 is taken offline. It is only then possible to use Capture from 
PlanetPress® Workflow 8. 
 

4. Colour Model in Stylesheets 

 
In Version 1.0 the colour model of colours defined in a stylesheet can sometimes change after 
editing the stylesheet. This is a known issue and will be addressed in a subsequent release.  
 

5. PlanetPress® Connect Version 1.0 available in32 Bit Only 

 

PlanetPress® Connect Version 1.0 is available as a 32 Bit application only. 64 Bit will be 
introduced in a later release. 
 

6. Indexes in PlanetPress® Fax and Image 

 

PlanetPress® Fax and Imaging are unable to archive with indexes in Version 1.0. This will be fixed 
in Version 1.1.  
 

7. Online Help Links Point to Introductory Page 

 
Context sensitivity for the online help is disabled in PlanetPress® Connect Version 1.0 meaning 
that all links and F1 calls currently point to the introductory page of the help. Context sensitivity 
will be re-introduced in a subsequent release of PlanetPress® Connect. 
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8. Legal Notices and Acknowledgements in the Connect About box 

 

In PlanetPress® Connect Version 1.0, the link to the “Legal Notices and Acknowledgements” in 
the About box currently points to the introductory page of the online help. To read the legal 
notices you must navigate through the online help using either the contents tree or a search. The 
path for this link will be addressed in a subsequent release of Connect. 

 

9. Online Help for Workflow 8 

 
In Workflow 8 the online system currently points to the legacy help system of PlanetPress Suite 
7.6. This will be fixed in a subsequent release. 

 

10. Job does not Cancel on Error 

 
The Designer can sometimes appear to hang when encountering an error. If you then attempt to 
abort the job, the job does not cancel. 
 

11. Black Screen sometimes appearing in the Designer 

 
The Designer window can sometimes turn black after opening and closing multiple templates. 
This is a known issue and will be addressed in a later release. 
 

12. Registration of PReS Plugin for Watch 

 
In the current version of PReS (6.3.0) the dll for the PReS Plugin for Watch has to be installed and 
registered manually. This will be automated with the release of PReS 6.3.1. 
 

13. PDF Output sometimes produces random error 

 
When running PDF output multiple times, an “Object XX is not defined” error can sometimes 
occur. This problem only occurs on Windows 8.1 and will be fixed in a later release. 
 

14. Dragging and Dropping a Step into a Condition 

 
Dragging and dropping a step into a condition or repeat step can sometimes delete the step. This 
will be addressed in a later release. 
 

15. Encoding 

 
Issues may sometimes being encountered in menus and templates when running PlanetPress® 
Connect on a non-English operating system. These are due to encoding issues and will be 
addressed in a later release. 
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16. Hebrew 

 
Note that Hebrew is not fully supported in Version 1.0. Full bi-directional processing of Hebrew 
will be introduced in a later version of PlanetPress® Connect. 

 

17. Templates and Data Mapping Configurations from earlier Betas and Release Candidates 

 
Please note that templates and data mapping configurations created in earlier Betas and Release 
Candidate versions may not open or function correctly in Version 1.0.  

 

18. Merge\Weaver Engines when Printing 

 
The print operation in the Designer will automatically detect whether the Merge\Weaver 
engines are available and display a message for the user to retry or cancel if not. Once the 
Merge\Weaver engine becomes available and the user presses retry the print operation will 
proceed as normal. This message can also occur in the following circumstances: 
 

 If the server is offline and you are not using proof print 

 On some occasions before the Print Wizard opens 
 

19. REST Calls for Remote Services 

 
The Server will now accept REST calls for all remote services and will make commands wait 
indefinitely until the required engines become available. The Server will log when it is waiting for 
an engine and when it becomes available. Note that there is no way to cancel any commands 
other than stopping the Server.  

 

20. Print Content and Email Content in PlanetPress® Workflow 

 
In PlanetPress® Workflow’s Print Content and Email Content tasks, the option to Update Records 
from Metadata will only work for fields whose data type is set to String in the Data Model. Fields 
of other types will not be updated in the database and no error will be raised. This will be fixed 
in a later release of PlanetPress® Connect. 
 

21. PlanetPress® Workflow Create Job task requires a Job Preset task 

 
In order to run the PlanetPress® Workflow Create Job task, you must select a Job Preset task 
first.  The Job Preset values themselves will be ignored, however, and the Job structure will 
actually be dictated by the metadata, not the Job Preset. This will be fixed in a later release of 
PlanetPress® Connect. 
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22. VIPP Output 

 
Some templates set up with landscape orientation are being produced as portrait in VIPP. It can 
also sometimes be the case that text and images can be slightly displaced. These are known 
issues and will be addressed in a later release of PlanetPress® Connect. 
 

23. Print Limitations when the Output Server is located on a different machine 

The following limitation may occur when using the Print options from a Designer located on a 
different machine to the Output Server: 

 The file path for the prompt and directory output modes is evaluated on both the client AND 
server side. When printing to a network share it must be available to BOTH the Designer and 
Server for the job to terminate successfully. 

 The Windows printer must be installed on both the Server and Designer machines. 

 When printing via the Server from a remote Designer, the output file remains on the Server 
machine. 


